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Typing Instructions Made Easy  
 

Please read these guidelines carefully: 

 
1. Typing: The text of the manuscript must be typed preferably in MS Word 2003 or 2007. But the 

mathematical symbols or equations should be typed using Equation Editor of MS Office 2003. 

The paper must be typed with single line spacing. 

2. The entire text of a paper is split into two sections. Section 1 comprises only the title page whereas 

section two comprises all other pages of the paper. Page setups of section 1 (the title page) and 

section 2 are different. So are the Headers and footers. The footer of section 1(the title page)  is 

used to provide corresponding author’s email address and the footers of section 2 are left blank 

unless authors want to use them as footnote for explanation of certain points in the manuscript.  

3.  Page Setup Margins: The following margins must be set as a part of page set up: 

 

Title page (Section 1): (first page of the paper) should have the following margins:    

Top 

Margin:  

3” Bottom 

Margin:  

1.2” 

Left 

Margin:  

1.63” Right 

Margin:  

1.6” 

Header:   2.1” Footer:   1.1” 

Gutter:   0” Gutter 

Position:  

Left 

 

      Other pages (Section 2):  (use commands: insert→break→next page and then set the margins 

        for section 2)     

Top Margin:    2.5”  

Other margins remain the same as specified above for the Title page.    

 Page Layout (under page setup): 

Headers and Footers are set at 2.1” and 1.1” from the edges. Headers and Footers are set to 

Different for first page and Different for odd and even pages.  

Page alignment is set from the Top. 

 

4. Various line spacing on the title page of the paper should conform to: 

 
     Keep the space between Title and Authors - 6 pt 

     Keep the space between Authors and Affiliation - 6 pt. 

     Keep the space between Affiliation and Received on (date) - 6 pt 

     Keep the space between Received on (date) and Abstract - 6 pt 

     Keep the space between end of Abstract and Keywords - 6 pt 

     Keep the space between Keywords and the Introduction (First Section Heading) - 12 pt 

 

5. Title of the paper should be as brief as possible and should meaningfully convey the intent and 

contents of the paper. The title of the paper should be typed in Garamond fond size 14 pt. in bold 

in Title case. Like this: 

 

Performance Analysis of a Multistage Interconnection Network 
System based on a Minimum Cut Set Method  
 



Note: Title originally communicated should not be changed at any stage without bringing it to the 

knowledge of the Editor-in-Chief. However, in case the title needs to be changed; a new copyright 

agreement should be filled in and submitted prior to the publication of the paper. This is a 

statutory requirement. 

 

6. The Authors’ names should be typed in capital letters in Times New Roman size 10 pt. normal. 

Affiliations of all coauthors must provide full postal address without giving the website or email 

address or telephone or fax numbers. However, the corresponding author must be identified 

with an asterisk raised to the name and his email address must be given in the footer of the title 

page (see at § 15.2). The authors’ affiliations should all be done in italics in Times New Roman 

size 9 pt. In case all authors have same affiliation, please follow this style: 

 

6.1   In case of single author: 

SUPRASAD V. AMARI* 

Relex Software Corporation, 

540 Pellis Road, Greensburg, PA 15601, USA 

 

 6.2   In case of multiple authors but common affiliation: 

 

A. D. TELANG
*
 and V. MARIAPPAN 

 

Faculty, Department of Mechanical Engineering, Government Engineering College, Farmagudi, Ponda-Goa, 

India: 403 401  

 

              6.3    In case of multiple authors with different affiliations, please follow this style: 

 

YOICHI HIGASHIYAMA
1*

 and VENTSI RUMCHEV
2
  

1Department of Electrical and Electronic Engineering, Ehime University 

 Matsuyama, 790-8577 Japan 
2Department of Mathematics and Statistics, Curtin University of Technology 

 P.O. Box U1987, Perth, WA 6845 Australia 

 

Note: Sometimes, communicating authors insist on including or excluding names of coauthors at 

some stage of publication. This is improper and creates complications. Authors originally included 

should not be changed at any stage. 

 

7. Date of receipt of the paper (same as received by you in the acknowledgement of your paper) 

must be typed in italics in Times New Roman size 9 pt after affiliations.  Example: 

 
        (Received on February 15, 2006) 

8. Abstract should be typed in font size 9 pt (Times New Roman) and generally be of one 

paragraph but in rare cases not exceeding two paragraphs (100-200 words). The style  should be: 

 
Abstract:  Noncoherent systems can model a wide range of practical systems. The non-monotonic property 

of the structure function makes their analysis difficult. Therefore, despite the general nature of noncoherent 

systems, there are far fewer publications on noncoherent systems than coherent systems. 

 

9. Keywords not more than 5 should be typed in font size 9 pt (Times New Roman). These are 

required to help the abstracting agencies in abstracting and bibliographical databases. Example: 

Keywords: noncoherent systems, system failure frequency, number of failures, prime implicants. 

10. Starting with Introduction, all sections must be consecutively numbered and should appear in 

bold 10 pt. in Times New Roman.    



 

11. The entire text of the paper should be done in 10 pt. NORMAL Times New Roman.   

 

12. The starting paragraph of a section should not be indented but other paragraphs of any section 

are indented by 0.25”.  

 

13.       Headings: All headings of sections or subsection including should be done in 10 pt. Times New 

Roman and Bold. 

14.      Each Heading should have a separation of 6 pt. from the text above and below. 

Once we reach the - Acknowledgement (if there is any): the text would be 6pt above and 6 pt 

below from the headings. 

References: Text would be 12 pts above and 6 pts below from this heading. 

  

15. Headers and Footers  

15.1      Title page Header (Section 1) should be typed in Times New Roman (font size 8 pt.) as     

follows:      

 
International Journal of Performability Engineering, Vol. 4, No. 2, April 2008, pp. 111-120. 

© RAMS Consultants 

Printed in India 
 

The volume, issue number, month and the year are generally communicated to the corresponding 

author at the time of accepting a revised paper by the Editor-in-Chief.  

 

15.2     Title page Footer is reserved for the corresponding author’s email address and the starting 

page number (which is always odd and is typed in Times New Roman of pt. 8 at the right-hand 

corner of the footer) should be given as follows: 

_____________________________________ 
 *Corresponding author’s email: jmk@vergina.eng.auth.gr                                                                                                   3 

 
 

15.3      Even page Headers 
 

The subsequent page numbers on the even pages are given in Times New Roman of pt. 8 size on 

the left-hand corner of the even page header along with the names of the authors (in the middle of 

the header) like this: 

 
                  3                                                                  J. M. Kontoleon and K. A. Mehdi 

 

 

15.4      Odd Page Headers 

 

Also, the subsequent odd page numbers (except the title page which is also an odd numbered 

page) are given on the right-hand corner of the odd page header along with the title of the paper 

(in the middle of the header) in Times New Roman of 8 pt. size like this: 
 

                                              A Distributed-bit SEC-DED RAM with a Self-Testing and Repairing Engine                                               3 

 

Please note that while the page number on the title page (odd page) is typed in the footer, the page 

numbers of all odd pages are typed in the header. If the title is too long, it can be typed in Times 

New Roman of 8 pt. in two rows like this: 

 
                                                           A Discrete NHPP Model for Software Reliability Growth with                                                        3 

Imperfect Fault Debugging and Fault Generation 
 

15.5 Setting Headers and Footers in MS word 

 



For setting HEADERS-FOOTERS, on the title page and other pages, the paper is divided into two 

sections, the first section contains only the Title page and rest of the paper would be in section 2. 

Please note that it is NOT a page-breaking but a section-breaking. To do this bring the cursor at 

the end of the main text of the Title page, choose Insert tab on MS Word and select break option 

and in the various options available in the break, select under section break types, next page 

option. This operation will divide the paper in two sections (section one, consisting of Title page 

and the other section will have the rest of the paper). This may also need to slightly adjust your 

text to be fitted on section 1. This is primarily done to set top margin on Title page different from 

the top margin of the rest of the paper. As mentioned earlier, the top margin in Title page is set to 

3’’ but we need to change it to 2.5” in the rest of the paper keeping other margins as the same as 

set for the title page). To do this, bring cursor to any point on page 2 of the manuscript or paper, 

select File → Page Setup →Margins, set Top margin to 2.5” (in place of 3”). No change in other 

margins is required. 

                 
Now, we are ready to set Headers and Footers for various pages. Remember that Header and 

Footer of Title page are different from the Headers and Footers of other pages. Other pages are 

also categorized as even pages and odd pages (excluding the title page, which is always is an odd 

page but we treat it differently than the other odd pages). 

  

1. In an open word file, select View →Header and Footer. About 11 icons escorted by 

insert auto text and close on either sides of these icons appear in a tool box of Header 

and Footer that appears on your open word file. These icons correspond to, insert pager 

number, insert number of pages, format page number...etc.  

 

2. Select the icon corresponding to → page setup (which looks like an open book icon and 

is 6th icon on my computer) among these. A Window pops up. Check the boxes: (i) 

Different odd and even pages (ii) Different First page. 

Place cursor at the Header of Title page (Section 1) and insert the Header as defined in 

15.1.  
 

3. Bring cursor at the Footer of Title Page, Select Insert → Page numbers from the main 

menu. Again a window of Page Numbers pops up. In this window, set, position → 

Bottom of page (Footer), set Alignment → Outside, check the box Show number on 

first page. Also, select Format. Again a new window of Page Number Format pops up. 

In this window, which helps you choose the starting page number, select Start at: and set 

starting page to the starting page number allotted to you using Times New Roman 8 pt ? 

Close the windows by pressing OK buttons. The Footer on Title page should appear as 

given in 15.2.  

 

4. Bring cursor to the Header of second page of your paper. Now you will see that you are 

in Section 2, You may see Int. J  of Per. etc... also written in this Header. Follow this: 

 

o Please Check the 9th icon (One square between two rectangles on the top and 

bottom) out of 11 icons stated above. Bringing the cursor over it, it shows -same 

as above icon pressed. If it is already pressed, unpress it by clicking the mouse 

over it. 

 

o Delete the contents of the Header (if you forget to unpress then Section-1 

Header will also be deleted) and copy/ paste the authors' name by setting its size 

8 pt. Insert → page number → outside from main menu. Check on the format 

→ continues from previous section.  

 

o This will insert the page number continued from last section. In other words, if 

first page was 305, the next insertions would be 306 automatically. Please note 

that all page numbers on even pages should appear of even pages and all page 



numbers on odd pages (except title page which is also an odd page) appear of  

the odd page. 

 

o Bring the cursor to third page Header. Copy and paste or type (please check very 

carefully what is typed by you.  Otherwise same mistake would be carried over 

to all odd pages) the title of your paper. Insert page number, press OK. The 

next page number will be inserted at appropriate place. 

 

o This will fill all the alternate odd pages with the title and page numbers. 

 

o Now select the close button of 11 icons to end this process. 

 

o You must observe that all even page Headers contain the page number (on the 

left-hand top corner of the Header) and the authors’ name (in the middle of the 

Header). Like the one given in 15.3. 

 

o Also all odd page Headers contain the Title of the paper ( in the middle of the 

Header, if necessary in two rows if the title is too long) and page number (on the 

right-hand top corner of the Header). Like the one given in 15.4. 

 

o Once this is done, please check for accuracy of Headers and Footers. 

  
16. Introduction must be necessarily the first section of the paper. But in case Notation and/or 

Assumptions are required in the paper, these must be provided at the end of the Introduction 

where all symbols used in the paper must be defined.   On can employ two-column table to have 

consistent separation between the symbol and its meaning by choosing table properties → 

border and shading → none. Please note that while the Introduction is typed in font size 10, the 

Notation is done in font size 9 (Times New Roman). Example of Notation is given below: 

Notation 

n number of components in the system 

m number of product terms in the expression for U 

p number of prime implicants (PI) of the system 

i
d  event that PI-i exists at time t 

i
θ  event that PI-i occurs in [t, t + ∆ t] 

,
i i

λ µ   [failure, repair] rate of component i 

,
i i

p q  [availability, unavailability] of component i; 1
i i

p q= −  

,
i i

ω ν  [failure, repair] frequency of component i;     and   
i i i i i i

p qω λ ν µ= =  

  

17 Sections and Sub-sections 

 
17.1   All sections and subsections must all be numbered sequentially as given below:  

 

   1.      Introduction 

2.      Accident Sequence Analysis (First Level) 

2.1    System Accident Model (Second Level) 

2.2     System Analysis 

2.3     Global System Model 

2.3.1   Physical Behaviour Model (Third Level) 

2.3.2   Safety Control Actions 



  2.4      Derivation of Disturbance Path 

 

Please avoid going to more than three levels of numbering of sections. One can use italic sub-section 

headings after third level heading. 

 

18      Equations 

 

All equations must be sequentially numbered and must be typed using an Equation Editor. The 

style of giving equation is as follows: 

( )

2

2

1







 −
−

= σ

µ

α

x

A ex      (4) 

 

Please note that (4) (is inserted using insert equation number command in MS word) has been 

typed at the edge of the text and the equation is usually centred. Further no dots (....) are required 

before the bracket of equation number or between the equation and equation number (usually 

resorted to by many authors). Also if an equation is quoted in the text, it is done simply writing as 

“The membership is calculated using (4),” It may be noted that it is not essential to write the word 

equation before (4), unless we have a situation where we begin the sentence with the word 

equation like:  

 

“Equation (4) provides the membership function  ...” 

 The above referencing of equation in flowing-text can also be done using insert equation reference  

               command in MS word.   

19      Tables 

 
All Tables must be done in font size 9 (Times New Roman) including their captions. Please note       

               the style of writing a caption and placement of a table (centred) as given below: 

    
 Table 1: Inputs to Parameter Estimation 

 

Parameter definition Parameter Value 

Length of rail L 365 km = 365 000 m 

Number of tests/inspections 1989-2002 nTF 9.4 

Number of tests/inspections 1991-2002 nTD 8 

Number of days, 1989-2002 N1 5027 

Number of days, 1991-2002 N2 4299 

Length of test/inspection interval T 537 days 

Number of observations in state D1, (i.e. 

transitions from D1u to D1d ) 
ND1 331 

Number of observations in D2 when it was not 

known that state was degraded,  

(i.e. transitions from D2u) 

 

ND2a 

 

449 

 

 

20 Figures 

 

Captions of the figures must be placed below the figures and it should be typed in font size 9 

(Times New Roman) as shown below.  

 
Please check the quality of figures of your paper. Please choose an appropriate size of letters so that the 

readability and clarity of legends is good and not hazy. Oversize letters must also be avoided. 

Lines should not be too thin or too thick. Here are the examples of good and bad figures. 



 

 

 

 
 

  
Figure 1: Example of a good Figure Figure 2: Example of a bad Figure 

 

If necessary multiple Figures can be put side-by-side in the boxes with suppressed borders as has been done 

in case of the two figures shown above. 

 

 

21     Conclusion 

 

All papers must have a numbered section on conclusion. Many a times it is found that the 

conclusion and Abstract seem to look alike. It should not repeat what has been said in Abstract. 

On the contrary, it should conclude the outcome of the research described in the paper. Avoid 

using headings like Concluding Remarks or Summary etc. 

 

22      References 

 

All references must be thoroughly and carefully checked for complete details and should be 

sequentially numbered as they appear in the text. Please follow the Vancouver style of listing of 

references. The sequence of information in a reference should be author(s), title of the paper (in 

italics), Journal’s name, year of publication; Vol. ?, No. ?, pp. ( pages from X to Y ) and finally 

month. All this information makes a reference complete. Otherwise it is incomplete. The style is 

as follows: 

 
[1]. Moteff , John, Claudia Copeland and John Fischer. Critical Infrastructures: What Makes an 

Infrastructure Critical? United States Congressional Research Service 2003; The Library of Congress.   

[2]. Prezant, D., J. Clair, S. Belyaev, D. Alleyne, G. Banauch, M. Davitt, K. Vandervoorts, K. Kelly, B. 

Currie and G. Kalkut. Effects of the August 2003 blackout on the New York City healthcare delivery 

system: A lesson for disaster preparedness. Critical Care Medicine 2005; 33(1): S96-S101 (Supplement). 

[3]. Chen, J., J. S. Thorp, and I. Dobson. Cascading dynamics and mitigation assessment in power system 

disturbances via a hidden failure model. Electrical Power & Energy Systems May 2005; 27(4): 318–326. 

[4]. Apostolakis, G.E. and D. M. Lemon. A Screening Methodology for the Identification and Ranking of 

Infrastructures Vulnerability Due to Terrorism. Risk Analysis 2005; 25(1): 361-376. 

[5]. Wood, A. and B. Wollenberg. Power Generation Operation and Control. John Wiley, New York; 1996. 

[6]. Billinton, R. and W. Zhang. State extension for adequacy evaluation of composite power systems- 

applications. IEEE Transactions on Power Systems 2000; 15(1): 427-432. 

[7]. Levitin, G. and A. Lisnianski. Importance and Sensitivity Analysis of Multi-State Systems Using the 

Universal Generating Function. Reliability Engineering & System Safety 1999; 65(3): 271-282. 

[8]. Ramirez-Marquez, J. E., C. Rocco, B. Assefa, D. Coit and M. Tortorella. New Insights on Multi-state 

Component Criticality and Importance. Reliability Engineering & System Safety 2006; 91(8): 894- 904. 

[9]. Zio, E., M. Marella and L. Podofillini. Importance measures-based prioritization for improving the 

performance of multi-state systems: application to the railway industry. Reliability Engineering & 

System Safety 2007; 92(10):1303-1314. 
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Quoting a Reference 

 

Also please note that while referring to a reference in the body of the paper, you need to just give 

its number within square brackets, like “In [5], it is assumed that...” If you do require quoting the 

name of the author (which is not necessary), then you must quote the author’s surname without 

initials or titles like Prof. Taylor etc., like, “In [5], Taylor has assumed that...” 

 
23     Appendix 

 
The purpose of an Appendix is to provide supporting proofs, corollaries or important 

mathematical derivations which cannot be easily found for published papers or books and are 

relevant for the understanding a paper. The appendix generally serves as a supplementary 

information to the paper. The entire appendix must be typed in font size 9 (Times New Roman). 

Appendix, if any, (like Appendix A, Appendix B etc.) are all given after references but before 

biographical sketch of authors. If they have their own equation numbers and should be distinct 

from the main text, like (A1), (A2),...,(B1), (B2) etc. 

 

 

24     Biographical Sketch 

 

Each coauthor can provide a very brief biographical sketch but all such bio-sketches put together 

should not exceed half a printed page of the journal. Photographs, if provided shall be printed in 

black and white. The style generally is as follows: 

Sarintip Satitsatian received the B. Eng. degree in Mechanical Engineering from King Mongkut 

Institute of Technology at Ladkrabang (KMITL), Thailand and the M.S. degree in Industrial 

Engineering from University of Washington, Washington.  She is currently doing her Ph.D. in 

Industrial Engineering at the University of Washington.   

Kailash C. Kapur is a professor of Industrial Engineering at the University of Washington, 

where he was also the Director from 1993 to 1999. He completed his Ph.D. degree (1969) in 

Industrial Engineering from the University of California, Berkeley. He has co-authored the book 

Reliability in Engineering Design, John Wiley & Sons.  He has written chapters on reliability and 

quality engineering for several handbooks.  

 

 

25 The number of pages of your paper must be kept as far as possible even since all papers are 

printed starting with an odd page number, and if the page length is not even, one page will be 

wasted while printing the paper as the next paper can only start from an odd page. Therefore, it is 

advisable to keep the length of a paper to an even number.  

 

Finally, in order help follow these instructions properly; a template can be obtained from the Editor-in-

Chief.  

 

 

 


